2024 Year End Summary 12/11/2024

USE AND DISTRIBUTION NOTICE

e Santa Clara County RACES authorization is granted to use and
duplicate this material as-is as long as this page and the
copyright notices on each page are included, acknowledging
Santa Clara County ARES/RACES as the holder of the
copyright.

e Permission is granted to adapt this presentation to your
needs as long as you acknowledge our copyright and include a
note similar to "adapted with permission from Santa Clara
County ARES/RACES”

e For additional information on training or any of our programs
send an email to: info@scc-ares-races.org
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2024 Year End
Summary, Update,
Preview

Santa Clara County ARES®/RACES
Revised: 11-Dec-2024

ARES and Amateur Radio Emergency Service are registered service marks of the American Radio Relay League Incorporated and are used by permission.
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Housekeeping

e Introductions
e Pen/pencil, paper
e Cell phones

e Side conversations

e (Questions WHAT WAS
LEARN HOW s 7
e Breaks 70 READ AND i
FOLLOW
e Restrooms INSTRUCT/ONS

AR
(%)

i

o , OF ALL KINDS!
e Do not park in side parking lot

e Do not wander around the building

e In case of emergency

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved. 3



2024 Year End Summary 12/11/2024

Agenda

e Message Passing Skills
e Training
e |CSForms

e Credential Updates

e Packet Network Update

e Monthly Packet Message Passing
e P1 and HF Credentials & SHARES
e Weekly Packet Practice

e Safety Issue Observed: no fuses in power cables
e Working with a Served Agency

e \W2XSC BBS Failure

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved. 4
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Message Passing Skills

Can you send what the served agency needs?

Tim Howard, KE6TIM
Revised 10-Dec-2024

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved. 5
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Why is Message Passing Important

» Trained Amateur Radio Operators
o Do more than push a PTT button.
o Know how to get agency specific messages from Point A to
Point B accurately and efficiently, even when other systems
are failing.

* No mater how much experience you have, your skKills
become stale without practice.

* We encourage everyone to attend the training classes
every few years.

« We all think we are good enough, but how good is
good enough?

» Let's try some examples.

* No judgement, just some fun to see what we can do.

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved. 6
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Some Examples

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved. 7
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Santa Clara County ARES®/RACES

Message Handling

Procedures

Revised: 28-June-2024

https://www.scc-ares-races.org/operations.shtml#MHP

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved.
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Message Passing Skills

» We schedule two Message Passing Classes each year.
o January 27%
o July 19t

« Quarterly Training Nets on the 3@ Tuesday of the 1st
Month in each Quarter at 7pm on the Resource Net
Repeaters is another opportunity to learn and practice.

« January 215t - details on web site--sign up.

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved. 9
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Training

Judy Halchin, KKBEWQ
Revised 22-Nov-2024
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Classes

e 24 training classes in 2024
* 16 unique classes

40 people in Introduction to Emergency
Communications classes
(not counting instructors and staff)

2025 schedule is very similar to this
year’s

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved. 11
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Practices

 Monthly packet practice
e Pop-up packet drill

Quarterly message passing practice

Quarterly drills at County EOC radio
room

* Annual exercise in September

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved. 12
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Hospital Training

* Hospital employees got ham radio
licenses (or already had them)

* |CS-214 and ICS-309 training videos

e Basic voice and packet training for
hospital employees

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved.
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2025

2025 Santa Clara County ARES/RACES/ACS -- Training/Activity Calend
TRAININ January February March April May June July August September October November December
FieldOps Type3A | Field Ops Type38/2 | NetControlType3A | NetControl Type 38 Event Planning PacketType3a | m_’. m’"‘;::_"' Packet Type 38
WK1 Date: Sat1/4 Date: Sat2/1 Date: Sat 3/1 Date: Sat4/5 Date: Sat 6/7 Date: Sat8/2 Date: Sat9/6 Date: Sat 10/4
Instr: Howard Instr: Howard Instr: Howard Instr: Howard Instr: Howard Instr: Roth pree Instr: Roth
Loc: SO audtorium | Loc: SO auditorium | Loc: Sunnyvale DPS | Loc: Sunnyvale DPS: Loc: Sunnyvale DPS Loc:Sunnyvale 0PS | (108 e | Loc Sunnyvale PS
Intro to Em Comm NetControl Type2 | RDF Search & Locate. PacketType2 | Endof Year Summary
WK2 Date: Sat2/8 Date: Sat5/10 Date: Sat6/14 Date: Sat11/8 Date: Sat12/13
Instr: TBD Instr: Howard 1c:T8D Instr: Oberhofer Instr: SCCStaff
Loc: Sunnyvale DPS Loc: Sunnyvale DPS Loc: TBD Loc: Sunnyvale DPS | Loc: Sheriff Aud.
Cross-Band Repeat Fundamentals of
Antenna Fund. Em Comm Quarterly Dril e I::/.z ] oy ;’:‘771;' s ‘::s':"’;,:” County-Wide Exercise <Placeholder>
WK3 Date: Sat1/18 Date: Sat 3/15 Date: Sat5/17 i : ate: Date: Sat9/20 County EOC Radio
Instr: Halchin Instr: Howard Instr: Howard
Instr: Ott Instr: TBD | h i || et | e Loc: TBD Room Orientation
Loc: Sunnyvale DPS Loc: Sunnyvale DPS RYYE B a2 m
Message Passing RACES Unit Lead Fleld Ops Type 3A
Date: Sat1/25 G "s:"'i,"u Date: Sat3/22 Date: Sat 26
WKa Instr: Howard Rt nstr Howard Instr: Howard
Loc:Sunnyvale DPS Loc: SCCOEOC Loc: SO auditorium
i S
WK5 Date: Sat8/23 ks
10am - 12 noon Zem
LoC: SCCoEOC
—
EC Council Meeting. ECCounci Meeting 5 o EC Council Meeting m:s:r[au i EmComm
EVENING Date: Thur2/13 Date: Thur5/8 " aa Date: Thur 8/14 N NIGHT CLASS
) o BD o g i{pm Instr: TBD
LoC: SCo EOC L0C: SCCoEOC . 8D LOC: SCCoEOC
s

Loc: Sunnyvale DPS

Date: Wed. 11/12
Instr: TBD

Loc: Sunnyvale DPS

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved.
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ICS Forms

Tim Howard, KE6TIM
Revised 10-Nov-2024

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved. 15
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Forms Updated in 2024

* In 2023 the Public Health Department relocated their

operations center and renamed it:
o Was: Medical Health Joint Operations Center - MHJOC
o Is: Public Health Department Operations Center - PHDOC

» This resulted in updates to Hospital Forms and the
Recommended Form Routing Sheet.

» We are still seeing numerous cases of MHJOC still being
used instead of PHDOC.

« The Recommended Form Routing Sheet is your friend.

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved.
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Forms Updated in 2024 (Cont.)

 The RACES Mutual Aid Request Form was updated.

« The primary changes were on page two used at the
County EOC to assist with resource assignment and
tracking.

« Some changes on the front for cities.
» Those are used by city ECs/AECs and the changes

were shared with city RACES leaders at a quarterly EC
Council Meeting.

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved. 17
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Errors in Form Completion

» \We continue to see errors in form completion.
* Primarily 214 Activity Log and 309 Communications Log.

» Judging from the call signs, it is mostly newer operators;
but, some experienced operators also make errors.

* S0 new or experienced, we all can do better.

» These forms are legal documents and need to be
accurate.

» Let’s review some of the more common errors to help us
all learn. Names have been redacted to protect the
innocent.

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved. 18
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What is missing or could be improved

1. incident nd A 2. Operational Period {Date/Time}
R AT o [eB[2d  af2B(zoen
ARESRAGES— KXo — 24 ~07 T From: \2.(3 To: |fTa'a)
3. Radio Net Name (for NCOs) or Position/Tactical Call 4. Radio Operator {Name, Call Sign)
§. COMMUNICATIONS LOG
Time FROM TO
{24:00) Cafl Sign/iD Msg # Call Sign/iD Msg #
\228 | -2  suT3-¢déh XN\ 213 - VIe2o\ j:rcuwze) \ao\uvx\qus
o odw 9 toe vt =kt

For Ak e Aweany te

v

y 220 YN\ | Al dodons o3t T PN AWAOIR
x , B SP2-6P¥5 = q
g -3 HT2-¢¢99 R
! |
8. Prepared By (Name, Call Sign) BA. Si ure 7. Date & Time Prepared 8.

Page Z of 2

= {23/2\{ \405 e

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved. 19
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What is missing or could be improved

COMM Log | 1. incident Name am‘:l Activation Number ) ’ , 2. Operational Period (Date/Time}
ICS 309-SCCo C?"""ﬁ““ﬂ‘j cle Compmnicatio 9/2 9’/ 24 29/57
ARESIRACES | Clergse  XS5c-2%4 fa' b
3. Radio Net Name (for NCOs) pr Position/Tactical Cafl T
Ao _3
5. )
Thos FROM v
P =i e
0052 o Bortart: o farK _ Obo 72/
0% o4 A Arrived
0?07 &4&4(’./ pit o8 e secnree
vo)d obhe cfael [0 T SCagig ¥l
00 H?c,o o /’32551 Ner

{6A. Signature 7. Date & Time Prepared 8.

?/ZVA? Page__Lof_____

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved. 20
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What is missing or could be improved

1. Incident Name and Activation Number 2. Operational Period (Date/Time)

UNIT4_|;(c)cG Councd WIDE CommenicbionN> 04-28- M 59 -28-21

ICS 21 O | FnuetcISE " VAL NDR- PrRfté— : _ B

ARES/RACES eSC-249 - )T From: O% 20 To: /5:0
3. Unit Name / Tactical Call / Designators 4. Unit Leader (Name, Call Sign, ICS Position) J
5. Personnel Roster Assigned

Name Call Sign ICS Position Home Base/City

6. ACTIVITY LOG

Time (24:00) Major Activities & Events / Occasional Messages (indicats From [ To / Msg#/ Msg Taxt)

08 $2| teae honse 0DO O

H556 /;fv('”"e’ (Zasnot e

o020 N '

0650 [Chade ity st85,n¢
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What is missing or could be improved
COMM LOg 1. Incident Name and Activation Number 2. Operational Period (Date/Time)
fﬁgg;&iggg X.g C ’ZL{ -—O‘ﬂ_ From: To:
3. RadiolNet Name (for NCOs) or Position/Tactical Call i i
Chelter 2
5. COMMUNICATIONS LOG
Time FROM TO
- Message
(24:00) Call Sign/ID Msg # Call Sign/ID Msg #
103 N L[]atﬁm to /\J?—'
2 MNC  xWpHoj 02601 | Chefter  Llatq S | -2
24 : So2~(PI KJO-102| Shelle~ Stetus
i }Jc, (Ve onfj }m.u—( Loqpb=r vice aHhis fim
~ ANp-is SO2HOZ| Sapplics gou requeste’ FOB8 ||
L GoR—c02 ML AND-185 | Srape Auvenue blocred 213
1257 C P8 $2-6073
2.5 : N(_, we will AazA f-o-‘vlﬁ\){ EPore jum}owv
; ‘ T — .
130 sopeo] NC-  (ND-jio | Sheerr  SHPUS
2@ [ vC WOz [Nss sea-604 [0 — cote ~ urgent

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved.
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What is missing or could be improved

Continuation of the same form

(\; c’ : Rp»’-b QF{a"'{For') bb“{d i}:‘%rﬁ:{ f‘:-l:f?-" S ¢

MC  Wwo-|ls 02-805 |213 1 Hegy winds <let
262 | O XwWe-lF 502406 |21% | Requesitiens
103 h iV AND-VY 0407 | 21> | S‘i-‘r";: lie¢ w il arav< gcor

Nd check-out of het or release [from assignment

6. Prepared By (Name, Call Sign) 6A. Signature 7. Date & Time Prepared 8.
_ C\I‘,l);)g;’;q - ” i

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved. 23
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What is mlssmg or could be improved

COMM Log
ICS 309-SCCo
ARES/RACES

2. Operatiol fl Peri d(Dalemme) I

T° /2a9

From: Mﬂo

o - 1«{’ o777

COMMUNICATIONS LOG

5.

Time FROM TO Message
(24:00) Call Sign/ID Msg # Call Sign/iD Msg #
753 | — CEsapiE W ET LEAE (HomE o z5é
i q — (Gocruee JET | APZEE fhywe PEEODD 26)
b3 | — s1ATAe O |COE T SrpsTil
o | — S bk 48 | CHger. T Spbga—
G- | — e — — =1
o g s pP5 ol
ng:[q i /ué&smé T | Cuecr I (MEESAGE VET
2q:0T |\oe (o Sdé'/w Jes, 23| |
Q22 | — A5y | -1z | SperEsrms
;%0 AR S 21 - |
a4y | — 1 K0Py 1o | Lo CBIcD MESGHEE
w:2¢ | — |ap03 - g | Tes 2zl I
lo:43 = S¥ (oY XD -2 | Twpemp IMEEASE
2
0.5% (23 |greee Q{oy 125 213 | |
o e % . MESBAGE AET CLBES
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Credential Updates

Tim Howard, KE6TIM
Revised 11-Dec-2024

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved. 25
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Earned Credentials/Endorsements 2024

Credential | Field Operator Net Control |Packet Operator Shadow
Typel 0 1 3 0
Type ll 1 1 0 0
Type lll 2 2 2 2

Type IV 2
Endorsement Earned

Mutual Aid Communicator (MAC) 5

County EOC Radio Operator (ERO) )

County EOC RACES Unit Leader (RUL) 5

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved.
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Number of Credentials Earned by Type

Total Credentials and Endorsements

Credential | Field Operator | Net Control | Packet Operator | Shadow
Type | 5 7 3 5
Type ll 17 13 13 9
Type lll 42 30 33 20
Type IV 54
Number of Endorsements Earned
Endorsement Earned

Mutual Aid Communicator (MAC)

43

County Fire Station Radio Operator (FRO) (Pending) 0

County EOC Radio Operator (ERO) 17

County EOC RACES Unit Leader (RUL) B

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved.
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Credentialing

* Credentialing in technical fields (usually called
certification) has been used for 25+ years to verify an
individual’s ability.

* Credentialing is becoming more prevalent in Emergency
Management, especially where mutual aid may be
utilized.

e The State of California has a credentialing program for
EOC positions and many cities are having their staff earn
credentials.

* Served agencies are increasingly aware of credentialing
and are expecting team members to be credentialed.

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved. 28
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Credentialing

» Credibility: Credentials demonstrate your training,
knowledge, skills, and experience; and enhances
your credibility with peers and served agency
personel.

« Commitment: Earning credentials demonstrates
your commitment to the EmComm role, validates
your acquired sKkills as a volunteer, and can open
doors to leadership and training roles within the
organization.

« Assignments: Credentials can assure those that
assign you to a task know that you are capable of
handling whatever challenges the assignment
presents.

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved. 29
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Credentialing Program Handbook

ZOUN
L)

e
)
a

i |
of T

) 87
pivats

1 % A0

Santa Clara County ARES®/RACES/ACS

Amateur Radio Operator

Credentialing
Program Handbook

Version3.1.3

Revised: 26-Mar-2024

https://www.scc-ares-races.org/credentials/index.shtml#overview

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved.
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Database Update

If you have a County DSW, the sticker on

your DSW Card Expires at the end of el
December. DECEMBER
31
. . . x 2024
New stickers will be provided to your EC SCC OEM |

for distribution if you have updated your
database contact information by
December 315t

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved. 31
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My Profile

Update/Verify Contact Info

My Contact Info -

My Equipment

My Activity Record

My Completion Certificates
My Credentials

My MAC-Qualifying Events
Cities/Agencies 1 Support
Change My Call Sign
Change My Password

My Contact Information

Personal Information

call sign™ |W6XRL4 |

First Name™ Herman

Last Name™ Munster

Address 1* 1313 Mockingbird Ln
Address 2

City™ Mockingbird Heights
State™ TZ_

Zip= |00000 ]

Emergency Contact Information
Emergency contact™ Lily

Contact number®  |408-555-1212

Supported Agencies

You are on the rosters of these agencies:
County of Santa Clara

My Primary Agency

County of Santa Clara

If you are on multiple rosters, "Primary Agency"
is the agency that you vill most likely respond
to first in case of a wide-spread incident.

* denotes required field

You last reviewed this information on: 04/20/2024
I have reviewed the information on this page |
|Save Changes|

Contact Information
Home Phone# 408-555-1212

Work Phone#
Cell Phone#

Pager

e-mail #1 nonel@noone.com

e-mail #2 none2@noone.com

= denotes required field
# at least one number is required

AlertSCC Information

(format for phone & SMS numbers:
999-999-9999)

Phone #1 : |408-555-0001

Phone #2 : 408-555-0002
Phone #3 : |408-555-0003

e-mail #1: Iemaill@gmail.com
e-mail #2 : |email2@gmail.com

e-mail #3 : [email3@gmail.com

SMS #1%% : |408A555~1000

SMS #2== :|408-555-2000

** 5MS stands for Short Messaging Service
which is synonymous vith text messaging.

Note: These entries are prioritized.

Put your primary information as #1,
your second as #2, etc.

—

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved.
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Packet Network Update
2024 Year End Review

Jim Oberhofer, KN6PE
Revised 30 November 2024

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved. 33
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Highlights -- Outpost and PackItForms

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved. 34
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What’s in the box?

e SCCo Integrated Packet Installer 163C
*** PRERELEASE ***

e Qutpost Packet Message Manager
— GUI-based interface for managing packet communications

— Makes using packet as simple as using e-mail

e PackltForms
— Next generation HTML-based forms for use with Outpost
— Manual operation without Outpost

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved. 35
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SCCo Installer v163C
September 2024

PackltForm 3.16*

» Various forms and .pdf updates

* Even better manual operation support
» Auto-logging of sent and received messages
» Updated ICS-309 log maintenance
» Enhancements and bug fixes from user feedback

Outpost v3.8.6*

* Resolves 3 reported defects; adds 6 requested changes, including...
« Signature update on the ICS-309 comm log
« Address book address expansion with sent messages

*See the release notes for details

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved.
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What’s new
(or 6 things to make your packet life easier)

Setting up Message ID prefix for Tac Calls
Packet Forms and Manual Packet
Message search

Monitor RF Packet Traffic

Fixing JINOS extra line feeds

o vk wnN e

Packet Field References

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved. 37
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1. Setting up Message ID prefix for Tac Calls
Situation: You are deployed with a tactical call. You get a call from the EOC that
the tac call message ID is not set up correctly.
Problem: Message IDs are both unique and help reference the sending station.
Solution: Wit Outpost
1. Select Settings > Station ID... \dentification | BBS Logins| Signatures |
2. When you fill in your FCC Call
sign, Outpost picks up the last CltsE e ovsce
3 characters of your call as the | ,
Message ID Prefix e e o oL o _tew |
: User Name: [Herman Munster —
3. When setting up the Tactical Message D Profic [Ri4 (3 Characters may)
Call, you need to fill it in o gnemiEST |
yourself' v Usg Tachcal.call for all BBS interaction
4. Ask your shift supervisor or :::::;12?:; i[:::azzﬁcheckpnmt 56 o
exercise coordinator for what e _Delete |
this field value should be. B, R
Examples: Monthly Exercise: Tac Call=XND056 Msg ID Prefix = X56
City Deployment:  Tac Call=CUPDZA Msg ID Prefix = DZA
Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved. 38
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Situation:

Problem:
Solution:

Examples:

1. Setting up Message ID prefix for Tac Calls

You are deployed with a tactical call. You get a call from the EOC that
the tac call message ID is not set up correctly.

Message IDs are both unique and help reference the sending station.

Manual Operations
1. Find and click on manual.cmd

2. PackltForms picks up
the last 3 characters of your
FCC call as the Msg ID Prefix.

3. The Tactical Call Msg ID Prefix
does the same, but may not be
correct.

4. Ask your shift supervisor or
exercise coordinator for what
this field value should be AND
change this field if necessary.

Monthly Exercise:
City Deployment:

C @

Santa Clara County ARES/RACES PackitForms

User Call Sign: weXrRL4
User Name: Herman Munster

Message ID Prefix: RL4 (3 characters max)

Use Tactical Call Sign

Tactical Call Sign: xNDes6

Tactical Name: Xanadu Checkpoint 56
Message ID Prefi (3 characters max)
Archive Folder: c:\MyMessages\XND-24-1009T
Terminal Encoding: Windows-1252 v @

Next Message Number: 315

Tac Call=XND056 Msg ID Prefix = X56
Tac Call=-CUPDZA Msg ID Prefix = DZA

O D 127.00.1:55187/manual

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved.
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2. PackltForms

Submit to Outpost | Submit via Email | Reset Form Show Text Message
Message number: 6PE-618P
| OCheckin O Check Out |
Your Call Sign- || ybmit to Outpost | Submit via Email || Reset Form || Show PDF Show Text Message
) Use Tacticq
MESS/
Date ' : Version: 817
Santa Clara County EOC Resource Request Form 213RR M 23‘
07/23/2022 = =
Message Nurll| submit to Outpost | Submit via Emai I Reset Form | show PDF| | | = requir  Show Text Message |
Date:
ICS Posi| | ©7/23/2022
T WebEOC: 20190327
. ol 1cs Posi{ | S@nta Clara OA Jurisdiction Status GEE
O Name: | | Location| Message Null 5ipmit to Outpost | Submit via Email|  ResetForm | ShowpoF[ | | =
Telephor | O | Name: Date:
@7/23/2022 =
Subject: 10 Contact| | Santa Clara OA Shelter Status WebEOC: 201201 ‘
1 = ICS Posi| PIF- 22
Re'mmeiz &mmg&% T Location Message Nu. Submit to omwstl Submit via Emaill Reset Forml Show PDF
Message: =
5. Requested | O Name: | Datei ,
contact| = | Allied Health Status Report Short Form (bEoc-9) Pt Febmagf,g";g\
Report Type: | | 1 | Locatiof | Me3520¢ N\ Submit to Outpost | Submit via Emai l Reset Form || Show PDF required
0 N 7 Date:
Confact Infor) | erszaraen = Version: 20220129
E0C Bfone Contact cspo Santa Clara County RACES -- Mutual Aid Request e
2 Primary EM | RePort Type 1 Locat Origin: | Destination:
Secondary EY| | Shelter O Name:| Date: @7/23/2022  Time:[hh:mm ] Handiing: O Immediate (ASAP) O Priority (<1 hr) @ Routine (<2 hrs)
Hant Shelter Type Conia ICS Position: RACES Chief Radio Officer v IS Position: |
Status: . E can
= Report Tyg T Location: County EOC R | Location: |
‘ Office Status: ame: il O Name: a Name:
Address: F;M Contact Info: Contact Info:
City: Contact Na | pgency Natic )
el Event/ Incident Name: l Number:
= Other Pho
Assignment Duties, conditions, equipment, shift times
Facility Sta
Green - Ful Yy
4
‘Amateur Radio Qty Role Position Preferred Type Minimum Type
. £ le, Ch..
Copyright © 2024 Sa _JI 2 EXTT 40
v v
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3.

6.

7.

County Use of PackltForms

e Santa Clara County PackltForms contains these public forms
1.
2.

XSC Check-In/Out Message Form

XSC ICS-213 Message Form adapted for Santa Clara County to
transmit messages.

XSC EOC-213RR Resource Request Form — Requests specific resources
needed to support an emergency.

XSC OA Jurisdiction Status Form — Reports jurisdiction emergency
situation status to county OEM.

XSC OA Shelter Status Form — Reports information and status on
shelters opened in the cities to county OEM.

XSC Allied Health Facility Status — Reports information & status of
private Skilled Nursing facilities to SCC Public Health Department.

XSC RACES Mutual Aid Request Form — Used by a jurisdiction to
request a RACES Mutual Aid.

e The SCC Installer program automatically installs these packet forms
along with Outpost.

— Additional forms may be provided by your EC

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved.
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ICS 213 Message Form

EOC Resource Request 213RR
OA Jurisdiction Status

OA Shelter Status

Allied Health Status

RACES Mutual Aid Request
HAvBed Report

Medical Facility Status

Resource Regquest Form #9A

e Updates are in BOLD text

specific situation

Updated PackltForm Defaults
proutorms g 0 To caPoston o Lacsion

-- Planning Section County EOC

Immediate  Situation analysis Unit County EOC

Priority Mass Care and Shelter Unit --

Routine EMS Unit PHDOC

Routine RACES Chief Radio Officer County EOC
Immediate EMS Unit PHDOC
Immediate  EMS Unit PHDOC

Obsolete -- Replaced by EOC Resource Request 213RR

e Aligns with the RACES Recommended Form Routing Cheat Sheet; updated March 2024

e Fields can be changed at message create time
e Always double-check the RACES Recommended Form Routing Cheat Sheet for your

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved.
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Situation:

Problem:

Solution:

3. Message Search

This assignment has been in place for several shifts with plenty of
packet message traffic already passed.

Now, someone askes for a copy of a message you received. Where is

it?

1. On Outpost, click on the Search menu.

2. Enter some text that you know is likely part of the message, which

fields itis in (or
check all fields),
and whether you
want to check this

In Tray U ] Type] From w Message Search
or all folders. el e TUDe
3 p S h | OutTray F2  cup00B@wixs... cup@ [cupoos Search
B I( I Del cup008@w4x... sjcts
ess oearc SeNE0E F2  cup00B@wdx... sjcts| Include these fields to search ;
Del cup008@wix... sjcts gy
4. For 1 All Folders, | s ||| D' c00@wix: 3 sueane @ fiom  w lFoiers
. Del cup008@wix... knbe Message Text T
Type field shows ml F2 cup%%vﬂx... s B e ¢
the message Deleteg || [ Del cupdtB@wixs.. knbe [ LocalMsglD [ BBS
g : F2  cup008@wixs... knGe Match Tips
location | || B Comcongwanr o | 7 Machesany il charac !
) SCC Notices !! Del cup00B@wix... cupd atches any single character
| I Del cupﬂﬁﬂ@wu... cupd * Matches zero or more characters
Packet 3AHW !!' Del cup008@wilx... cup9
.—‘ Del cup008@wix... cupd [ Resetto full liston close Close | P
Printed I Del cup008@wix... CUP i
Messages !! Del cupbO8@wix... CUPEOC WIXSC1 CUP-1960P PDO-1
Exercise b
Messages
e e T el Py VR -.....-«..._.J

E Outpost Packet Message Manager

File Edit Setup Tools Forms Actions Help

New | Open | aschive | Delete | Print | Search | SendReceive | Profie

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved.
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Situation:

Solution:

4. Monitoring Packet traffic

Some users like to watch what is going on with on a frequency in
between Send/Receive Sessions to see if the frequency is clear.

1.
2.

From Outpost, Tools > Interactive Packet > Serial / Com Port.

From Ipserial, Tools > Options. Check ¥ "Turn on Packet Monitoring
(MON ON)...". Press OK.

. When you press Connect, Ipserial.exe sends the MON ON command

to the TNC to start monitoring.

. When Outpost starts a I 1oserial with Outpost i

Send/Receive session, it~ Fe it Tk fdp
requires the serial port Diconee] ‘et o] et Message]

* it tells Ipserial.exe to KANTRONICS PACKET COMMONICATOR ITT VERSION 5.1

C) C TGH] 993 BY KANTRONICS INC. ALL RIGHTS RESERVED.

disconnect. 7 SRR SR
DUPLICATION PROHIBITED WITHOUT
* It opens the com port

cmd:
* Disconnected by Outpostc
and Sends the necessary .+« Beconnected by Outpoatc

TNC & BBS commands.

PERMISSION OF KANTRONICS.

MONITCR ON
« When done, it tells ﬁjf‘m‘mﬁ Vay OFF
Ipserial to reconnect to '
the Com Port.

| Connectad b the TNE. | Settings: S600M.8:1 or Carom Port 1

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved.
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5. Fixing JNOS Extra Line Feeds Q"’*‘F/c*

Situation: JNOS causes message text lines greater than 127 characters to have a
CRI/LF inserted regardless of where it is in a sentence or word.
PackltForms handles this situation nicely. But what happens if an
Informal Message is sent? This is what it could look like...

From: XND056@w1xsc.scc-ares-races.org Local Msg ID: XND-2451P
To: XNDEOC ~

Subject: X56-172P_R_Observations from the field )

To: EOC Staff
From: Checkpoint 5€ observer
Subj: Observations from the field

Incident Summary:

On November 17, 2024, at approximately 3:15 PM, an urban wildfire broke out in the
hills adjacent to the Mt Pleasent Foothills

neighborhood. The fire rapidly spread due
vegetation and threatening residential ang
mmercial areas. Emergency services were dispal ed promptly, with firefighters,
police, and medical personnel establishi -@
and posts near Groesbeck Hill Park. Local ¥wekefities issued evacuation orders for
over 1,200 residents within a 2-mile radius

of the fire’s origin.

Rtrong Easterly winds, engulfing dry

On-Site Observations:
Upon arrival, the fire was observed to ='.ring in a northwestern direction, driven

by wind speeds exceeding 25 mph. Flame§
ached heights of 20-30 feet, with heavy 3m0
quarter mile. Firefighters used aerial watse
rops and aground-based suppression tactics to

gducing visibility to less than a

€ate a firebreak near critical

2,168
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5. Fixing JNOS Extra Line Feeds

If you come across this situation, try this:

1. In the message form, press View > JNOS Line Fix (BETA)

2. This change is not permanent and cannot be saved.

3. Pressing the forms’ Print button will print the original message.

4 - pe— e Tt S 2P AL > Y BrrTRE IR

Solution:

From:
Subj:

To: EOC Staff

Checkpoint 56 observer
Observations from the field

Local Msg ID: XND-2451P

From: XND056@w 1xsc.scc-ares-races.org
To: XNDEOC a
Subject: X56-172P_R_Observations from the field

Incident Summary:

On November 17, 2024, at approximately 3:15 PM, an urban wildfire broke out in the
hills adjacent to the Mt Pleasent Foothills neighborhood. The fire rapidly spread
due to strong Easterly winds, engulfing dry vegetation and threatening residential
and commercial areas. Emergency services were dispatched promptly, with
firefighters, police, and medical personnel establishing command posts near
Groesbeck Hill Park. Local authorities issued evacuation orders for over 1,200
residents within a 2-mile radius of the fire’s origin.

On-Site Observations:

Upon arrival, the fire was observed to be moving in a northwestern direction, driven
by wind speeds exceeding 25 mph. Flames reached heights of 20-30 feet, with heavy
smoke reducing visibility to less than a quarter mile. Firefighters used aerial
water drops and ground-based suppression tactics to create a firebreak near critical
infrasctructure, including a hospital and a shopping center. Despite these efforts,
at least five homes were completely destroyed, and several others sustained varying
levels of damage. Residents were seen evacuating in an orderlv manner. cuided bv

2,168
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5. Fixing JNOS Extra Line Feeds "?4/:,:,0*

Solution: 4. But, pressing File > Print will print the corrected version.

W6XRL4 as XND056

From: XNDO56@w1xsc.scc-ares-races.org

To: XNDEOC

Sent: 11/18/2024 20:56

Received: 11/18/2024 20:57

Subject: X56-172P_R_Observations from the field
Local Msg ID: XND-2451P

To: EOC Staff
From: Checkpoint 56 observer
Subj: Observations from the field

Incident Summary:

On November 17, 2024, at approximately 3:15 PM, an urban wildfire broke out in the
halles adaamarnt +~ +hae M+ Dlaasan+ Famthille nmatabkhlbarhaad Thae Fiva ramaidle smvaad dua=
hills adjacent tc the Mt Plsasent Foothills nsighborhood. The fire rapidly spresad dus
to strong Easterly winds, engulfing dry vegetation and threatening residential and

commercial areas. Emergency services were dispatched promptly, with firefighters,
police, and medical personnel establishing command posts near Groesbeck Hill Park.
Local authorities issued evacuation orders for over 1,200 residents within a 2-mile
radius of the fire's origin.

On-Site Cbservations:

Upon arrival, the fire was observed to be moving in a northwestern direction, driven
by wind speeds exceeding 25 mph. Flames reached heights of 20-30 feet, with heavy
smoke reducing visibility to less than a guarter mile. Firefighters used aerial water
drops and ground-based suppression tactics to create a firebreak near critical
infrastructure, including a hospital and a shopping center. Despite these efforts, at
least five homes were completely destroyed, and several others sustained varying
levels of damage. Residents were seen evacuating in an orderly manner, guided by
local law enforcement, though some individuals struggled to leave due to traffic
congestion and poor air guality.

T = Py -, - _ . art, PO T Sy oy e et
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6. Amateur Packet Radio
Field Reference, Type Il

What is it
¢ an Unofficial SCCo RACES reference.

e Provides a reminder (job aid) for
how to perform tasks that need to

Amateur Packet Radio
Field Reference, Type llI

For SCCo RACES Responders

October 2024

occur during a packet field
deployment.

e Helps ensure task consistency,

@)

completeness, and operational
alignment with SCCo RACES policies
and procedures.

What it is not

b

e the only source of information on
which you should rely.

e an official SCCo RACES deliverable.

120

48
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6. Amateur Packet Radio

Field Reference, Type Il Amateur Packet Radio
Field Reference, Type llI

Table of Contents 1

Bl R RRE R RN s A 1 For SCCo RACES Responders

I R — i
2.1 PERPESE - s R e e AR October 2024
2.2 HOW TO USE THIS HANDBOOK.......ccecvvvnenrnnnnn !

3 PACKET OPERATOR CHECKLIST.......

4 PACKET STARTUP PROCEDURE ....ocemeeeeereeeeeesseesessesssesenns 4

5 CLIENT SOFTWARE .cooeeooeeeeccnenanansscens 3

6

T I S I L e e e ((( )))
6.1 PACKET MESSAGING BASICS...........ciocnienmrmonsansmacsssnsnsassansinnsasenons é
6.2 FREE FORM (PLAIN TEXT) MESSAGE

6.3 SENDING A SPREADSHEET .CSV FILE — ONE APPROCH

7 MESSAGE ADDRESSING i S ,

8  STANDARD SUBJECT LINE FORMAT ...ooooeermrreseesesessresessseees j

9  CHECK-IN, CHECK-OUT MESSAGE........nererereene

10 RECOMMENDED FORM ROUTING CHEAT SHEET .....cuuu.... ,

11  ARCHIVING EVENT DOCUMENTATION i
11.1  CREATE THE ICS 309 COMMUNICATION LOG ........ooveeeoeereeeeeenen.. 4
112 CREATE A PRINTABLE LIST OF YOUR MESSAGES. ....ueueieieeneriiennnens i
11.3  CREATE AN ARCHIVE OF YOUR MESSAGES.......ccrerumsuesessnsussansasnsarand
114 RESET (CLEANUP) OUTPOST FOR THE NEXT EVENT ....ccuvvereenenennsens ’

https://bit.ly/PacketT3

120
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https://bit.ly/PacketT2

6. Amateur Packet Radio
Field Reference, Type Il

Table of Contents {
1 QUICK REFEREMCE .c.cuiiicisiiiissisnsinsassesssio sessisinsissisissanos 1
2  INTRODUCTION..couriannns e 4
21 BURPOSE... .cococicicincsivnssnsisis i mvmsisiossesniame simissvesssmissssias
2.2 How TO USE THIS HANDBOOKi
23 OTHER REFERENCES 1
3  MANUAL PACKET OPERATIONS.....cccunmmnmansmssnsnsssssassnsas
3.1 TNC Commmos{
3.2 BEBSCOMMANDS.............o. oo ccnnccnnsneacessannanasssmn
3.3 CONNECTING TOTHE TNCWITH PUTTY ..o 3
34 START OF SHIFT: CONFIGURE TNC SETTINGS .......ccconvvevnnranrans ‘(
35 END OF SHIFT: RESTORE TNC SETTINGS ... <«
3.6 GETTING READY FOR MANUAL MESSAGING.......coeeeeeeennnnel
3.7 MANUAL MESSAGE BASICS .......coeeeeeeeaeeeenenaaaaaennnens I
3.8 SENDING A MANUAL PACKITFORM MESSAGE.............cooee...... ‘
39 RECEIVING A PACKITFORM MESSAGE MANUALLY...................5
3.10 Noteson OutposT TAGS:
3.11  VIEWING SAVED MESSAGES ........cccoeeoeeeeeanemeaeaaneanaaaaaananns
3.12 Notes on Manual ICS 309 Comm Loc 1

Amateur Packet Radio

Field Reference,

Type ll

For SCCo RACES Responders

October 2024

AL

B
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mpmp, P1 and HF
Credentials & SHARES

Mark Laubach, K6FJC
14-Dec-2024
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January to November stats

Not Held
Jan Feb  Mar
Participants 24 21

Messages by participant by Type

ICS213 29 29
EOC213RR

Shelter Status

Allied Health Status 22
RACES Mutual Aid 26

CSsVv 26
Op-to-Op & Other 281
Total Messages 816 768

Apr May Jun
19 20 16
57 40 28
20 14

20
14
249 205 ?

674 577 387

33

11

11

11

38

330

Not Held
Aug

You can review all past practices on the MPMP Training Page:
https://www.scc-ares-races.org/training/practice/monthly-packet-message-practice/monthly packet-message-practice.html

Monthly Packet Messaging Passing Practice

Sep Oct Nov Totals

16

39
19

216

617

27

40
27
28

311

913

15 169
42 337
21 112
59
22
37
40
208 1508
602 5684
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Packet Credential Changes

» Packet Operator Type | (P1)
» Removing: out of county assignments
* Moving out of P1 to a new area of focus:
« Set up, manage, and troubleshoot a JNOS-based packet BBS
system, running on Ubuntu, etc.
+ Changing focus to W5XSC BBS to set up and operate for a training or
exercise event, with instructions from net team

» Refining knowledge items, digipeaters and nodes, and other problems
+ Etc.

* Motivations
* P1 should be on parallel with other Type 1 credentials, e.g., specialist
and plan, design, deploy, train, ...
* It’'s a lot of work to complete existing requirements
» P1 credential != county BBS sysop
+ Doesn'’t need to incorporate SCCo BBS sysop/network

* When: next Credential Program Handbook update

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved. 53
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Member of County Networking Staff

» The network team is looking for a few “good people”
* In discussion likely in the form of a member of
network staff position posting (likely)
« Discussed new endorsement not the way to go
» Recommendation from CRO and Pkt Manager
» Prerequisites: P2+, demonstrated team player
* Not for everyone, interview will be required with credential evaluator
and network team member — think of a position posting
» Successful interview,, candidate will be assigned mentor
« County BBS knowledge and demonstration (for all candidates)
» Building Ubuntu-based JNOS system to county configuration
« BBS JNOS sysop privileges demonstration, message and notice
management, log maintenance, Ubuntu tcp/ip networking, etc.
* Knowing what and what not to touch
» Additional skillsets desired among one or more of the following
* Network management, Network security, firewalls, monitoring, Network
routing, email (configuration, spam), devops, analysis, logging,
maintenance and upgrades, SCCo BBS operational knowledge, etc.

This is all under consideration and development

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved.
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Changes in County EOC Radio Room
HF Radio Remove / New State-funded HF Technology

* New radio technology has reduced the need for HF radio users to
deal with the complexities of HF propagation (solar conditions, time
of day, antenna orientation, etc.)

» State has called this SHARES for SHAred RESsources
+ SCCo OEM has two rigs: EOC radio room fixed and mobile unit

» The use of new technologies all but eliminates the need to be
concerned about HF propagation for state-wide EmComm purposes.

» The need for a three level HF Credential is being removed from the
Credentialing Program and a “SHARES Radio Operator
Endorsement” is being added to the next version of the Credentialing
Program Handbook.

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved.
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Changes in County EOC Radio Room
HF Radio Remove / New State-funded HF Technology

* The “SHARES Radio Operator Endorsement” will be available to anyone
holding the EOC Radio Operator Endorsement.

+ Early next year we will offer a SHARES HF Radio Orientation class for
those interested.

Quick Overview

* Based on Codan Communications equipment (Australia)

* Limited to state civil defense and emergency management agencies and some
select agencies within the state of California.

* Shared channels in the 2 to 8 MHz range. Access to 10 channels providing point-
to-point emergency radio coverage across the state. 24x7 Link Quality Analysis
and Automatic Link Establishment to eliminate ToD propagation concerns

* Operatesin accordance with FCC Rules Part 90 — Private Land Mobile Radio
Services (primary) and Part 97 Amateur

* All”push button”

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved.
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=

]
S
" —

SHARES Base Station HF Eq.uipment

......

Desk
Console
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SEMS - Reminder

Standardized Emergency Management System

Local

I ) Government
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* OA encompasses a county
* 58 counties
* Six mutual aid regions

NOTES

* Local governments may request
mutual aid directly from other
local governments where local
agreements exist.

* Discipline-specific mutual aid
systems may have procedures
that provide additional methods
of obtaining state resources.

* Volunteer and private agencies
may be involved at each level.

State

SEMS General Flow of Requests and Resources

State

Region

Agencies

Operational
Area

Affected

Local
Governments

Other
Regions
»|  State ¥
Agencies Operational
Areas
Unaffected Local l
Operational [~ Governments
Areas in OA
Unaffected
Local
Governments

In OA
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Weekly Packet Practice

Steve Roth, KC6RSC
Revised 11-Dec-2024
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Weekly Packet Check-Ins
(Unique Call Signs)

40

35
30
25
20

15

10

5

0

12/4/23 114124 2/4124 3/4/24 4/4/24 5/4/24 6/4/24 714124 8/4/24 9/4/24 10/4/24 11/4/24

e SPECS e===SVECS e===Combined
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Percent of Correct Messages (290%)
120
100 N/ s — —— —
\\ / N \\/W v ANAAVARRY, \4 \\7 :
80 \/
60
40
20
0
12/4/23 1/4124 2/4/24 3/4124 4/4/24 5/4/24 6/4/24 714124 8/4/24 9/4/24 10/4/24 11/4/124
e SPECS === SVECS Combined

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved. 62



2024 Year End Summary 12/11/2024

Average Score
100 s — . —

N\ VNSNS T T T —
90
80
70
60
50
40

30

20

0
12/4/23 1/4/24 2/4/24 3/4/24 4/4/24 5/4/24 6/4/24 714124 8/4/24 9/4/24 10/4/24 11/4/24

=== SPECS ====SVECS Combined
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Multi-Year Comparison

2018 2019 2020 2021 2022 2023 | 2024

Total Messages 2116 2844 3138 3226 3200 2932 2408
% Correct 93.2% 93.7% 95.5% 96.6% 88.4% 83.1% 98.3%
Unique Calls 25.5 29 31 30 27.4 34.3 32.0
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Mailbox Full — Now What?

You are assigned to a rarely used station.
You connect to the BBS, and it has 142
messages waiting. That will take forever!

1. Abort the connection
2. Switch to alternate BBS

3. Connect manually, list with LL. If the
backed-up messages are obsolete or
unimportant, kill them with K.
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Can’t Wait for Bulletins to Download?

You’'re waiting for a critical message but
Outpost wants to download the XSCPERM
bulletins. That will take too long!

1. Abort the connection
2. Outpost: Setup -> BBS - Receiving

3. Turn off “Retrieve Bulletins” checkbox.
(Don’t forget to turn it back on later!)
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Switching between RF and
TCP/IP network access
in Outpost

Using Profiles extensively

Andreas Ott, K6OTT
Revised 11-Dec-2024
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. you are in an EOC or tactical location e
. you know your primary and secondary = <—
BBS, your tactical call, your FCC call —
and know how to configure all this in
Outpost

. your main access to the BBSen has

2m/1.25m/70cm

BBS settings and access paths

Antenna

- >

Coax

Outdoors

WiFi

TCP/IP () Radio
“ &
Antenna

Outdoor
Ethernet

beenoverRF -
. you recently got connected to the
SCCo Systems TCP/IP Subscriber
Network (or your EOC location has
a wired Ethernet connection to our
network)

Triplexer

Indoors

56+ kbps
Radio

Ethernet

Firewall

LAN Switch

Ethernet

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved.
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Workflows on RF

. No Issues: you are using your primary BBS over RF

. primary BBS “unreachable”. you manually switch to the
secondary BBS, and announce this fact on a net to the
County EOC (and other stations) so that they can adjust
sending you messages to your secondary BBS address

. primary BBS “reachable”: you have the choice of
continuing on the secondary BBS or switching back to
the primary BBS (same..., announce it, so others know
where to find you)

— your easiest way of “switching around” is by using
Outpost Profiles

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved.
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Create RF Profiles

. the default Outpost profile after new install is “Outpost”

i» Outpost Packet Message Manager

File Edit Setup Tools Forms Actions Help
New | Open | Archive | Delete | Print | Search| SendJReceive| Profile: | BTN |

’ In Tray | | u | Type | From [ To | BBS [ LocaliD | Subject

. create new profile (nhaming convention below)

. for your primary BBS, device and StationID

. testit!

. repeat for your secondary BBS, then test some more!

. practice switching between profiles, do not forget to
“switch” and verify the radio frequency at the same time

. switching between RF bands on the same BBS without
changing the profile
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Profile Parameters

. BBS name
. device/connection
. Interface name
. StationID
(your callsign, tactical or FCC)

. Create, save as (use ~ in profile name as separator)
Examples:

. WIXSC~KPC3~COMSFTDI~K6OTT
. WIXSC~TELNET-W1XSC~K6OTT
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Parameter details

[ Station D is K6OTT 1,5 Device setup for XSC_Kantronics KPC3 X
Identﬂicaﬁon] BBS Logins | Signatures | Type | Prompts | THC Cmds | initcmds  Com Port | AGWPE | Telnet |
. ;- Comm Fort Seftings
Gurent Profle: [WiXSC-KPC3-COMBFIDIRBOTT < Station ID compott [Gome =] [ Echo-
rLegal ~MaxSpeed | | goon e et
User Call Sign: _ New I 9600 '] | Flow Control ——
UserName: [anareas Ot Delete ] - Connection Preferences - | € None
Wessage ID Prefic [oTT (3 Characters max) Daadis:[a <] & RTSICTS
Transmit PST: rl— Parity [None =
Taclical
[ Use Tactical Call for all BBS interaction T N C/CO m PO rt > Stop Bits: | 1 -
Tactical Call Sign |<Chaase:'Create(Hew} Tac Call> j New AL
Additional ID Text |
Message IDPrefic [~ (3Characters max)

Apply Canceal
[ Show this form on startup oK Anply ot I
finally: Save it
03 Outpost Packet Message Manager
File Edit Setup Tools Forms Actions Help
New BBS... Ctrl+B Search | SendReceive | Profile:[W1XSC~KPC3-COMSFTDI-KEC ]
Interface... Ctrl+T
Station ID... Ctrl+l
Address Book... | [ To | 8BS [ LocaliD__| subject
Poniey > N xnd098... W3XSC-1 X98-1042P XND-179P_F
: ew xnd@xsc  W3XSC-1 X98-1041P Xanadu City £
PC Time Check... Save XSCEV.. W3XSC-1  X98-1039P Xanadu City
Delete... xnd@xsc  W3XSC-1 X98-1040P Xanadu City
Copyright © 2024 Santa Clara County ARES®/RACES. All rights reserved. 72
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Create Telnet Profile

. for your primary BBS, telnet connection and StationID

. add username and password, remove colon “:” from
password prompt field

. test it!

. repeat for your secondary BBS

. test some more!

. when switching back to any RF profile, do not forget to
“switch” and verify the radio frequency to match the
BBS frequency on that band at the same time
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+ & Device setup for TELNET-W1XSC X

Type | Prompts | TNG Cmds | Initcmds | Com Port | AGwPE | Telnet |

Telnet details

1;» Device setup for TELNET-W1XSC

Type | Prompts | TNG Cmds | Init cmds | Com Port | AGWPE [ Telr

Choose a Name

LU R TEL NET-W1XSC -
Description:
Interface
cm &
- (o)
@ Telnet

IP, port >

prompt >

Copy
Delete

BBS username
and password >

0K I

[y Station ID is KEOTT X

Telnet Server

Remote Host  [44.450.1
Remote Port:  [23
Network Timeout:  [5000 RaCC
Logon Prompts.

Logon:  [Callsign - NOTE: Logen and
1 Password prompts are
Password:  |password

case sensitive.

Remove ':'

\dentification BBS Logins | Signatures |

Manage passwoid access lo specific BBSs

BBS logins for: K6OTT

New nge Delete
I i [
A

Log on as...

BBS Friendly Name

KG60TT XSC;WZXSCJ
K8OTT XSC_W3xsC-1 g
wvenTT Voo wiaven 4

BBS Name: |xsc_w1xSC-1

User Logon: [KsOTT
User/Connect FW’

Winlink Acct Password: |

Description:
Cancel

[¥ Show this form on startup

show |

ok | ey | cance |

ok | Cancel
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Workflows on Telnet

. No Issues: you are using your primary BBS over telnet

. primary BBS “unreachable”. you manually switch to the
secondary BBS, and announce this fact on a net to the
County EOC (and other stations) so that they can adjust
sending you messages to your secondary BBS address

. primary BBS “reachable”: you have the choice of
continuing on the secondary BBS or switching back to
the primary BBS (same..., announce it, so others know
where to find you)

— your easiest way of “switching around” is by using
Outpost Profiles
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Switching around

Always verify Outpost status bar on the bottom

1/ Outpost Packet Message Manager

File Edit Setup Tools Forms Actions Help

New | Open | archive | Delete | print | Searcn | SenaRe

V einet~K60TT
m | W2XSC~KPC3~COMSFTDI~KE0O

IryTtey u | e [ From [0 [ 588 i XS-1PC3-COMSFTDI-K80
ghelt aces.org xnd098... W3 W3axsC~teinet~K60OTT
OutTray B KkSott@w1xsc.#nca.ca.usa.noam md@xsc W3 W3XSC-telnet~XND09S
B kGott@w1xsc.scc-ares-races.org XSCEV.. W3)W4XSC~KPC3~COMSFTDI~KEO
SentMsgs B xndeoc@w1xsc #nca.ca.usa.noam xnd@xsc  W3)W4XSC~telnet-KEOTT .
B 1xsc.scc-ares-races.org XSCEV.. W3XSC-1 X98-1038P Xanmadu Cour
Archive Xndeoc@w1Xsc.SCC-ares-races.org W3XSC-1 DELIVERED: |
= xndeoc@w3Xsc.scc-ares-races.org W3XSC-1 DELIVERED: |
Draft Msgs xndeoc@w3xsc.Sec-ares-races.org W3Xsc-1 X98-1035P XND-168P_F
_— XNdeOC@W3XSC.S0C-ares-races.org W3XSC-1  X98-1036P XND-169P_R
Deleted xndeoc@Ww3Xsc.Sce-ares-races.org W3XSC-1 DELIVERED: |
xndecc@w3xsc.soc-ares-races.org W3XsC-1 X98-1032P XND-185P_R
Ndeoc@w3xSC.5CC-ares-races.org W3XSC-1 X98-1033P XND-166P_R
SCC Notices XNdeoC@WIXSC.SCC-ares-races.org W3XSC-1 DELIVERED: !
—— *Ndeoc@W3KSC S CC-ares-races.org W3XSC-1  X98-1020P XND-163P_F
Folder 2 L4 xndeoc@w3rsC.scc-ares-races.org W3XSC-1 X98-1030P XND-162P_F
XNndeoc@w3XSc.Sce-ares-races.org W3XSC-1 DELIVERED:
xndecc@w3xsc.sCC-ares-races.org W3XSC-1 X98-1026P XND-159P_FR
foldsrs 3xsc org W3XSC1 DELIVERED:
—_—— XNAdeoC@WIXSC.SCC-ares-races.org xnd098.. W3XSC-1 DELIVERED:
Folder 4 xndeoc@w3xsc.scc-ares-races.org xnd098.. W3XSCA X98-1025P XND-157P_R
_ xndeoc@w3xsc.sce-ares-races.org W3XSC1 DELIVERED:
Folder s xndeoc@w3xsc.sCc-ares-races.org W3XSC-1 X98-1021P XND-154P_R
xndeoc@w3Xsc.sce-ares-races.org W3XSC1 DELIVERED: !
¥ndeoc@w3XSC.SCC-ares-1aces.org W3XSC-1 DELIVERED:

W3XSC-1 X98-1019P XND-146P_F
W3XSC-1 X98-1017P XND-144P_R

xndeoc@w3xsc.ScC-ares-races.org
xndeoc@w3Xsc Sce-ares-races org

xndeoc@w3XSC.SCC-ares-races.org W3Xsc-1 DELIVERED:
ndeoc@w3xsc.scc-ares-races.org W3XSC-1 DELIVERED:
xndeoc@w3XSC.SCC-ares-races. org W3XSC-1 DELIVERED:
xndeoc@w3XsC.SCC-ares-races.org W3XSC-1 DELIVERED:
xndeoc@w3xsc.scc-ares-races.org W3XSC-1 X98-1011P XND-138P_P
xndeoc@w3XSC.SCC-ares-races org W3XSC-1 DELIVERED:
andeoc@w3XSc.Scc-ares-races.org W3XSC-1 DELIVERED:

Items: 38 Unread: 10 ‘ KBOTT - XSC_W1XSC-1 — TELNET-W1XSC (telnet)
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References

For Outpost, see training slide decks from SCCo
ARES/RACES Packet Operations classes

Packet Operations - Type |ll, Part A
Packet Operations - Type |ll, Part B
Packet Operations - Type |l

and of course the Outpost Documentation
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Safety issue observed:

no fuses in power cables
Batteries are no fun

Andreas Ott, K6OTT
Revised 11-Dec-2024
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Energy content in a battery

® Energy content in a (SLA) battery:
3.6 * voltage * mAh = Energy [Joule]
Example: SLA 12V@18Ah
3.6 12 * 18,000 =777 kJ

(approximate energy needed to boil 1/2 gal of water
from room temp)

® Energy density in LiFePO4 battery:
> 3x of SLA battery by weight, also
higher load current possible
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The Big Short

Now picture this: if your battery shorts
out, you will set free most of the energy
in a fraction of one second (aka. boil
the water in < 1 second). Until
something fails, such as the wire
melting, or the battery liquids heat past
their boiling point, with “steam” quickly
escaping.
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Rapid Unscheduled Disassembly

Escaping electrolyte steam usually leads
to the entire battery exploding. [*]
Good engineering practice is to insert
something into the circuit that will fail
before it turns into an incident,
preferably a protective device such as a
fuse. “All circuits shall have fuses”.

* “Don’t try this at home - go to a friend’s house.”
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Fuses to the rescue

DC power
supply cable
(sccepsory)

Fuse holder

Power cord (DC

(direct current) =)
138V) ﬁ 5<

Rear side of main body

)

-

TN

image credit: KOBG/Yaesu

Protecting battery and load (equipment)
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Charge controllers with
electronic load limiters

Check the manual: They will recommend
minimum wire sizes and fuses, at least
at the battery and the power source!

. 06 image credit: Renogy
D C Loa d ° Solar Panel Fuse [
2 O a m p S Battery Fuse
+ -
T + - b -
cutoff [T
Solar Panel Battery DC Load
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Working with a Served Agency
Golden Eagle 2024

Jeff Grafton, AJ6XZ
Revised 10-Dec-2024
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Golden Eagle 2024: Hellyer Park C-POD

e Simulated M7.5 earthquake

* County OEM established Type Ill C-POD
in Hellyer Park

* Simulated cell phone outage at site

 RACES mobilized to provide comms
between C-POD site and EOC
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Golden Eagle 2024: Hellyer Park C-POD
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Golden Eagle 2024: A few surprises

 RACES wasn’t in the org chart...
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Golden Eagle 2024: A few surprises

Bot RE W WF A0 UEDY
Situation Summary: A M7.5 earth- !

ey

' Patron Ingress quake along the San Andres Fault
Ve O r t e oawenEyieas impacted the County of Santa *
Clara leaving 50,000 residents
-4 Commodies without power. You have been ac-
. &P Secunty Post tivated to support CPOD opera-
sitemap
. Cones
x Barncades
Ginpiiee YOU DO NOT HAVE ACCESS TO CEL-
. LULAR COMMUNICATIONS SERVICES
Supply Trucks
Forkift
Flow Control Post . site information: ’
LoadingRation Point Employee parking located in the
Specialist
oo spaces on approach te the C-POD i
[“ Patron Vehicle > and Outlined in the pre-exercise r
\ packet. L )
@ Restiooms % > - Make sure you have signed into the

* start all communications going
to persons not at the CPOD with _‘
THIS IS AN EXERCISE

exercise

In the event of a real world emer-

gency begin communications 2. Flow
with THIS IS A REAL WORLD EMER~- 3. loading
GENCY 4. Supply
Intheeventelafivtiveatanng Hellyer Park Cottonwood Parking
injury call 911 then report the inci-
dent to the Exercise Controller Lot C-POD MOp
|}
ALY . TR h i ol | a
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Golden Eagle 2024: Field Setup
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FRS radios were used for
on-site comms

* The IC expected RACES
would handle all comms,
including FRS

RACES staff had not been
briefed on use of FRS

Golden Eagle 2024: More surprises

.7Ch nge Chan
scan Chan 1

nnnnnnn
Speoker
Lock Key- -»7~‘

Motorola CLS 1410 Radio

Radio Etiquette:

1. Start by announcing the position you want to
speak to (i.e. Flow Crew Lead)

2. Tellthem who is calling (i.e. Loading Point
Lead)

3. Be specific in your message, speak clearly, and
without long pauses

4. Don'tinterrupt! You cannot talk and listen at
the same time

Start all communications going to persons not at
the CPOD with THIS IS AN EXERCISE

In the event of a real world emergency begin
communications with THIS IS A REAL WORLD EMER~
GENCY

In the event of a life threatening injury call 911 then
report the incident to the Exercise Controller
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EOC

 RACES provided
blank forms and
coaching

» Handing off the
Recommended
Form Routing
Cheat Sheet
worked wonders

Golden Eagle 2024: Message flow

* Many incident staff (including IC) were
unfamiliar with forms and message flow to

SCCo ARES/RACES Recommended Form Routing

Usage:

This cheat sheet summarizes the recommended Handling, To Location, and To ICS Position when sending official forms via amateur radio.
The message authar can select whatever Handling Order, Te Location and ICS Position (s)he chooses for each message.

staffed, send it to the branch. If the branch is not staffed, send it to the section.

Sending: As a general rule, address a message to the most specific ICS position that is staffed at the destination location. If the specified unit is not

o Delivering: As a general rule, deliver the message to the leader of the “To ICS Position” identified in the message: Unit Leader, Branch Director, Section

Chief, or their Deputy. If that position Is not staffed or available, deliver to the next higher position in the ICS hierarchy shown below.

Form Type [ Handling To Location ** | To ICS Position **

General EOC
[

1C5-213 Message Fo Author defined Author defined | Author defined

If “Priority” (Field 11) is: | Then “Handling” is:
Now | immediate (ASAP)

EOC-213RR Resource Request High (0-4 hrs) | Immediate (ASAP) County EOC Planning Section
Medium (5-12 hrs) | Priority (<1 hr)

Low {12+ hrs) | Routine (<2 hrs)

| situation Analysis Unit

OA Jurisdiction Status Immediate (ASAP) County EOC ‘ Else: Planning Section

o T
Fordltymanaged: | \1,cs Care and Shelter Unit

OA Shelter Status Priority (<1 hr} - mu:“l"v‘[xnm 4 | Else: Care and Shelter ranch
County £OC | Flse: Onerations section

** For actual EOC activations, use the default To Location and To ICS Position(s) as indicated, unless told otherwise by the message originator.

Far an ARES/RACES exercise o training event, use the information given for that event, e.g. “Xanadu EOC” may be specified instead of “County EOC”, efc.

Santa Clara County ARES/RACES Revised; 20240318

Page10f2
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Golden Eagle 2024: Operations

* RACES sent and received multiple 3"-

party messages over packet and voice

e |CS-213
e 213RR with routing slip
* Informal

e Cross-trained operators

* Able to fill in while others were coaching
incident staff or taking breaks
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Golden Eagle 2024: Takeaways

e Exercising with served agencies is
invaluable

e Keep current on training and practice so
you know how message flow works

 Semper Gumby!
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W2XSC BBS Failure
June 8th —16th

Tim Howard, KE6TIM
Revised 16-Nov-2024
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Initial Evaluation
* Problems with W2XSC were reported

* A number of remote troubleshooting steps were taken.
o The network connection between the BBS PC and
the other network infrastructure at the site had failed.
o The JNOS BBS, the TNCs, and the Radios were
fully functional.
o The BBS was usable as a standalone BBS without
external connectivity to the rest of the network.

» It was determined that a spare computer, data switch,
and data cable should be taken to the site.

» Because of the remote location of the site, other parts,
tools, and equipment were collected for the trip.
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Plan for Trip to Site

« Over a one hour drive one-way

» Take anything you might need. Spare parts for repair
and also backup monitor, keyboard, mouse, tools, etc.

* Need a high clearance vehicle in good weather, 4WD at
other times.

 Because of the remote location we want to send at least
two people.

|t took a couple of days to get the material together.
* The keys to access the site were not readily available.

* Once on site, it was quickly determined there was a
cable issue.
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» Cable was replaced

* TNC Firmware updated

* General cleaning and
inspection of cabinet

* Remote testers
checked all radio, BBS,
and email connections
to the site

* The site was up and
back to normal
operation

Initia

|V
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Less than 16 hours later

« The BBS failed with the exact same symptoms. Remote
diagnostics indicated a similar failure.

» A second visit the next day was scheduled with spare
parts, a hardened data cable, and mouse deterent.

EACH BLOCK KILLS % 12 MICE™

BAIT STATIONS RESISTANT
4 EAcH ConaninG KI STATION

Chiid Resistant, Dispasable Station
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Second Visit

« The same data cable was chewed breaking wires
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» The data cable was replaced with the shielded cable.

* No additional problems with mice eating cables

» Site owner has placed more traps and sealed any
openings found. Reminded tenants to keep door closed.

« Thanks to:
Thomas Leibold — spare parts and technical expertice
Bertrand Achard — extra tools and computer monitor
Tim Howard — driver and support
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Additional W2XSC Issues

« PG&E PSPS power shutdown

o Generator started but shutdown failed due to
overheating

o Fan Blades were broken providing no cooling air

o Mice or larger rodents had got inside the fan shroud
and when engine started the fan blades broke off.

o Our batteries did not work due to several years of use
with numerous PG&E and generator issues

« Site owner has enclosed all openings to the generator
with wire mesh to allow air flow but block mice and other
rodents from access

* New batteries are on order and when they arrive a site
visit will be scheduled
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Q&A

All Training Staff
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Thank You!

Please check your email and follow the instructions to
complete and return the Course Evaluation.

To get course credit the Course Evaluation is due by next
Saturday.

If you have questions or feedback about this or other training activities,
you can join our Training discussion group.
https://scc-ares-races.groups.io/g/training

This is a moderated group.

See you at a training class or exercise next year!
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